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1. Introduction
This m anual provides in struct ions and suppor t  to firearm  dealers using the 

In ternet  to in it iate a background eligibility check with  the Californ ia Depar tm en t  

of J ust ice (DOJ ).

The followin g topics are covered in  th is m anual:

• “DROS En try System  Overview” . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 8

• “Background Eligibility Checks” . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 8

• “The In ternet  Process”. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 8

• “DROS Service Cen ter”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 8

• “About  th is Manual”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 8

• “Hardware an d Software Requirem en ts”  . . . . . . . . . . . . . . . . . . .  page 10
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DROS Entry System Overview

The Dealer ’s Record  of Sale (DROS) En try System  is a com puter  system  used by 

the Depar tm en t  of J ust ice (DOJ ) to process a DROS and to generate DOJ  notices 

and bullet in s.

TIP: Have your 

CFD ready before 

calling the ser-

vice center.

The DROS En try System  is available to receive and send in form ation  from  7:0 0  

a.m . un til 11:0 0  p .m . seven  days a week.

Background Eligibility Checks

The Dealer’s Record of Sale (DROS) In tern et  process is used  to obtain  

in form ation  necessary to per form  background eligibility checks for  firearm  

purchasers. After  the in form ation  is obtain ed , it  is subm it ted to the DROS En try 

System  and a DROS num ber  is autom atically assign ed. Once th is num ber  is 

assigned, the m andated  wait ing per iod  begins. 

The Internet Process

The Internet Process involves en ter ing DROS in form ation  th rough  a com puter  

with  access to the Internet. Through  the In ternet , the com puter  con nects to a 

secured  website and the DROS En try System .

The DROS En try System  windows con tain  the sam e in form ation  found on  a 

DROS worksheet . Using a computer to enter information is not an “instant 

check” system. The com puter  en ables dealers to en ter  in form ation  d irect ly in to 

the system  rather  than  com plet ing a DROS worksheet  that  is processed 

m anually.

Once the required  in form ation  is en tered  in to the system  and sen t  to the DOJ , a 

DROS n um ber  is gen erated . A DROS can  then  be viewed and pr in ted usin g the 

DROS En try System .

If the background eligibility check results in  a den ial or  delay, a not ice is 

generated  by the DOJ . That  not ice can  be viewed and pr in ted using the DROS 

En try System . In  addit ion , the dealer  is not ified by m ail and telephon e.

DROS Service Center

The DROS Service Center provides suppor t  for  issues per tain ing to the DROS 

En try System  and is available to all firearm  dealers. The DROS Service Cen ter  

can  be reached by calling 1-800-974-3767 from  9:0 0  a.m . to 9:0 0  p .m . Mon day 

th rough  Saturday, and from  10 :0 0  a.m . to 6:0 0  p .m . on  Sunday.

About this Manual

In  order  to m ake the in form ation  con tained in  th is m anual clear  and easy to 

read, cer tain  fon t  types and form att ing styles are used.
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The type styles are descr ibe below:

NOTE: Look for 

important notes 

and tips in the 

margin, like this.

• Words in  italics in dicate a text  box, screen  nam e, or  any item  found in  the 

applicat ion . Italics are also used to em phasize im por tan t  in form ation . 

For  exam ple: Advance the cursor  to the Last Name field .

• Bold words indicate a but ton  or  tab. For  exam ple: Click the Submit 

but ton .

• When  in struct ions refer  to pressing a “key,” they are refer r ing to a key on  

the keyboard .
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Hardware and Software Requirements

This sect ion  descr ibes the m in im um  hardware and software requirem en ts 

necessary to use the In ternet  applicat ion .

Your  dealersh ip  m ust  have the following item s:

• Celeron , Pen tium  or  equivalen t  desktop or  laptop com puter

NOTE: The DOJ-

supplied com-

puter (or compati-

ble) and HP 

DeskJet printer 

fulfill the hard-

ware require-

ments.

• Modem  28 .8  (or  h igher)

• Win dows-com patible pr in ter

• Windows 95, Windows 98 , Windows NT, Windows 20 0 0  or  Windows XP 

Operat ing System

• Microsoft  In ternet  Explorer  4.0 , 5.0 , 5.5 or  6.0

• In ternet  Service Provider  (ISP)

• Mag str ipe reader
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2. Getting Started
This chapter  explain s how to con figure In ternet  Explorer  before in stalling the 

In ternet  applicat ion . Th is chapter  also guides you th rough  the process of 

downloading and in stalling the applicat ion  on  your  personal com puter  an d 

set t ing up In ternet  Explorer  to pr in t  a com pleted  DROS. It  also descr ibes how to 

log in to the applicat ion  and change a password.

The following sect ions are included in  th is chapter :

• “Downloading and In stalling the DROS Applicat ion”  . . . . . . . . . . page 12

• “Set t ing Up In ternet  Explorer  to Pr in t  a DROS”  . . . . . . . . . . . . .  page 19

• “Logging in to the DROS En try System ”  . . . . . . . . . . . . . . . . . . . . . page 21

• “Changing a Master  or  Secondary Password” . . . . . . . . . . . . . . . .  page 27
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Downloading and Installing the DROS 
Application

To in stall and run  the CFIS DROS In ternet  applicat ions, you m ust  have an  

In ternet  Service Provider  (ISP) and be connected  to the In ternet . 

NOTE: To set up 

Internet Explorer 

and install the 

most current ver-

sion of the DROS 

Entry System 

application, all 

steps in this 

chapter must be 

followed.

Contact  your  ISP for  in form ation  on  set t ing up and establish ing an  In ternet  

con nect ion .

To Install the DROS Application

1. Open  Internet Explorer. Do th is from  the Start m enu by choosin g Start 

> Programs > Internet Explorer.

Or

Double-click the Internet Explorer icon  ( ) on  the desktop.

The Internet Explorer window appears. The default  page for  In ternet  

Explorer  is www.m sn .com . H owever , if you have changed your  hom e 

page or  your  ISP uses a d ifferen t  hom e page, that  page will be d isp layed.

2. Open  the Internet Options window:

TIP: Check which 

version of Inter-

net Explorer you 

are using by 

selecting Help > 

About Internet 

Explorer from 

the menu. 

If you are using Internet Explorer 4.0, select  View > Internet Options 

from  the m enu bar  at  the top of the window. If you are using Internet 

Explorer 5.0, 5.5 or  6.0, select  Tools > Internet Options from  the m enu 

bar  at  the top of the window. 

The Internet Options window appears, as shown  in  Figure 1. By default , 

the General tab is selected .

TIP: To set the 

DOJ Bureau of 

Firearms website 

as your home 

page, enter the 

Uniform 

Resource Loca-

tor (URL) in the 

Address field in 

the Internet 

Options window. 

By doing this, the 

DOJ website will 

be displayed by 

default when you 

open Internet 

Explorer.

Figure 1:  The Internet Options Window
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3. Click the Security tab to d isplay the secur ity opt ions sect ion  of the 

screen , as shown  in  Figure 2.

Figure 2:  The Internet Options Window With Security Tab Selected

4. In  the Internet Options window, click the Custom Level but ton  to 

d isplay the Security Settings window, as shown  in  Figure 3.

Figure 3:  Figure 4: The Security Settings Window
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5. Set  the following ActiveX con trols and plug-in s to Enable. Do th is by 

clicking the radio but ton  next  to each  opt ion .

The ActiveX con trols and  plug-in s to be set  to Enable are:

• Download sign ed Act iveX con trols

• Run  ActiveX con trols and plug-in s

NOTE: If these 

radio buttons are 

set to Prompt, 

you will be 

prompted each 

time you log into 

the application. 

Setting them to 

Enable is a time-

saving measure.

6. Set  the following ActiveX con trols and plug-in s to Disable. Do th is by 

clicking the radio but ton  next  to each  opt ion .

The ActiveX con trols and plug-in s to Disable are:

• Download unsigned ActiveX con trols

• In it ialize and scr ipt  ActiveX con trols not  m arked as safe

7. Click the OK but ton  to save the chan ges to the secur ity set t ings.

8 . A warn ing m essage appears (Figure 4) prom pting if you are sure you 

wan t  to change the secur ity set t ings. Click the Yes but ton .

Figure 4:  The Warning Message

Once you click the Yes but ton , the applicat ion  return s to the Internet 

Options window, as shown  in  Figure 2 on  page 13.

9. In  the Internet Options window, click the OK but ton  to return  to the 

Internet Explorer window.
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TIP: To add this 

website to your 

list of favorites, 

choose Favorites 

> Add to Favor-

ites from the 

menu bar. Navi-

gate to a page in 

your favorites by 

choosing Favor-

ites from the 

menu bar and 

selecting the 

website from the 

list. This elimi-

nates the step of 

typing out the 

website every 

time you wish to 

navigate to that 

site.

10 . In  the Address field  at  the top of the screen , en ter  the following address:

http://caag.state.ca.us/firearms

11. Press the Enter key.

In ternet  Explorer  open s the DOJ Bureau of Firearms website, as shown  

in  Figure 5.

Figure 5:  The DOJ Bureau of Firearms Website

12. Click the CA Firearms Dealer DROS Entry System Access lin k located  

near  the bot tom  of the page. I t  is listed  under  the heading Firearms 

Dealer Information and Tools, sim ilar  to Figure 6 .
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Figure 6:  The Link to the DROS Entry System Website

Internet Explorer opens the m ain  DROS Entry System window, as shown  

in  Figure 7.

Figure 7:  The Main DROS Entry System Window
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13. To in stall the Act iveX con trols and  plug-in s required  to run  the DROS 

In ternet  system , click the Setup but ton  (shown  in  Figure 8 ).

NOTE: The 

DROS Entry Sys-

tem application 

takes an average 

of 12 minutes to 

download and 

install using a 

28.8 speed 

modem. Installa-

tion times will 

vary depending 

on connection 

speed and net-

work traffic.

The CFIS PSD Setup window appears, indicat ing that  the applicat ion  is 

down loadin g and in stalling on  your  com puter .

Once the ActiveX con trols and  plug-in s are in stalled , the DROS Entry 

System Login window appears, shown  sim ilar  to Figure 8 .

Figure 8:  The DROS Entry System Login Window

14. Click the Cancel but ton .

15. Click the DROS Entry System Main Page link at  the top of the CFIS PSD 

Setup win dow to return  to the m ain  DROS Entry System window, shown  

in  Figure 8 .

You have now successfully com pleted  the in it ial in stallat ion  of the DROS 

En try System  applicat ion  for  the In tern et . The in it ial in stallat ion  in stalls 

key com ponen ts of the applicat ion . The m ost  curren t  version  of the 

applicat ion  will be in stalled  when  you fir st  log in to the m ain  DROS Entry 

System window. This in stallat ion  takes con siderably less t im e than  the 

in it ial in stallat ion .

16. Click the DROS Entry but ton  to launch  the DROS Entry System Login 

win dow.
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NOTE: Each time 

the DROS Entry 

System Login 

window is 

launched, the 

application auto-

matically checks 

to see that the 

most current ver-

sion of the appli-

cation is installed 

on your com-

puter. Occasion-

ally, when a new 

version of the 

application is 

released, the 

login process 

takes longer. The 

installation pro-

cess takes an 

average of two to 

five minutes to 

download and 

install using a 

28.8 speed 

modem. Installa-

tion times will 

vary depending 

on connection 

speed and net-

work traffic.

The m ost  curren t  version  of the applicat ion  is autom atically in stalled . 

When  the in stallat ion  process fin ishes, the DROS Entry System Login 

window appears, as shown  in  Figure 9.

Figure 9:  The DROS Entry System Login Window

For  in form ation  on  logging in to the system  and com plet ing the DROS 

en try process, follow the in struct ions beginn ing on  page 21.

The sect ion  “Set t in g Up In tern et  Explorer  to Pr in t  a DROS” on  page 19 

con tain s in struct ions for  set t ing up Internet Explorer to pr in t  a DROS.
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Setting Up Internet Explorer to Print a DROS

This sect ion  explain s how to set  up the pr in ter  set t ings in  In ternet  Explorer  to 

pr in t  a DROS. By following these steps, you will en sure that  a DROS will pr in t  

proper ly on  a single page.

To set up Internet Explorer

1. Open  Internet Explorer. 

In  Windows 2000, do th is from  the Start m enu by choosing Start > 

Programs > Internet Explorer. You can  also open  In ternet  Explorer  by 

double-clicking the Internet Explorer icon  ( ) on  the desktop. The 

Internet Explorer window appears.

or

In  Windows XP, do th is by clicking the Start bu t ton  at  the bot tom  of the 

screen  and choosin g Internet Explorer from  the pop-up window. The 

Internet Explorer window appears.

2. Choose File > Page Setup from  the m enu.

TIP: The Page 

Setup window 

can also be dis-

played from 

within the DROS 

Entry System 

application by 

clicking the 

Setup button 

from the Review 

DROS for Sub-

mitted Application 

window.

The Page Setup window appears, as shown  in  Figure 10 .

Figure 10:  The Page Setup Window

3. In  the Page Setup window, select  an d delete the text  con tained  in  the 

Header and Footer fields.

4. Change the Left, Right, Top and  Bottom m argin s to 0.25.

When  fin ished  delet ing the Header  and Footer  and changing the 

m argin s, the Page Setup window should  look like Figure 11.
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Figure 11:  The Page Setup Window With Fields Cleared

5. Click the OK but ton . The Page Setup window closes and returns to the  

Internet Explorer window.

6. In  the Internet Explorer window, choose View > Text Size > Smaller 

from  the m en u.

7. Close the Internet Explorer window by clickin g the X but ton  in  the upper-

r igh t  corn er  of the win dow.
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Logging into the DROS Entry System

Before you can  use the DROS En try  Applicat ion  to process a DROS, you m ust  

fir st  log in to the applicat ion . Th is sect ion  descr ibes how to do th is.

To Log Into the Application

1. Turn  on  the com puter .

2. (If necessary) in  the Enter Network Password window, en ter  worldcom 

in  the User Name field .

3. (If necessary) in  the Enter Network Password window, en ter  worldcom 

in  the Password field .

4. Click the OK but ton .

5. Once the com puter  has fin ished star t ing up , open  an  Internet Explorer 

browser  window. 

In  Windows 2000, do th is from  the Start m enu by choosing Start > 

Programs > Internet Explorer. You can  also open  In ternet  Explorer  by 

double-clicking the Internet Explorer icon  ( ) on  the desktop.

or

In  Windows XP, do th is by clicking the Start but ton  at  the bot tom  of the 

screen  and choosin g Internet Explorer from  the pop-up window.

6. In  the Address field  at  the top of the screen , en ter  the following address.

TIP: To add this 

website to your 

list of favorites, 

choose Favorites 

> Add to Favor-

ites from the 

menu bar. Navi-

gate to a page in 

your favorites by 

choosing Favor-

ites from the 

menu bar and 

selecting the 

website from the 

list.

http://caag.state.ca.us/firearms

7. Press the Enter key.

In ternet  Explorer  open s the DOJ Bureau of Firearms website, sim ilar  to 

Figure 12.
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Figure 12:  The DOJ Bureau of Firearms Website

8 . Click the CA Firearms Dealer DROS Entry System Access lin k located  

near  the bot tom  of the page. I t  is listed  under  the heading Firearms 

Dealer Information and Tools, as shown  in  Figure 13.

Figure 13:  The Link to the DROS Entry System Website
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Internet Explorer opens the m ain  DROS Entry System window, as shown  

in  Figure 14.

Figure 14:  The Main DROS Entry System Window

9. In  the m ain  DROS Entry System window click the DROS Entry but ton . 

The DROS Entry System Login window appears, as shown  in  Figure 15.

NOTE: Each time 

DROS Entry Sys-

tem Login win-

dow is launched, 

the application 

automatically 

checks to see 

that the most cur-

rent version of 

the application is 

installed on your 

computer. Instal-

lation times will 

vary depending 

on connection 

speed and net-

work traffic.

Figure 15:  The DROS Entry System Login Window

10 . If an y drop-down  m enus are not  populat ing in  the applicat ion , click the 

Version check box (shown  in  Figure 15).

This forces the down load of drop-down  m enu opt ions. Th is check box 

should  on ly be checked if any drop-down  m enus are not  populat ing. 

Checking th is option  increases login  t im e by two to five m inutes.
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11. En ter  your  Dealer ID and Password in  the appropr iate fields an d click 

the Login bu tton . For  in form ation  on  obtain ing a Dealer  ID and 

Password, see the sect ion  “Receiving a Dealer  ID and Password” on  

page 31.

TIP: To change 

your password, 

see “To Change a 

Password” on 

page 27.

The DROS Entry System Login window appears as the process of 

connect ing to the secured  In ternet  site begins. If an  invalid  password or  

Dealer  ID is en tered, a m essage is d isplayed, as shown  in  Figure 16.

If the following m essage appears, click the OK but ton  an d then  type your  

Password and Dealer ID again  in  the DROS Entry System Login window. 

The process of connect ing will begin  again .

NOTE: The 

Dealer ID and 

Password are 

case sensitive. 

Information that 

is required to be 

entered as upper-

case or lower-

case characters 

is considered to 

be case-sensi-

tive. For exam-

ple, the words 

“user id” and 

“USER ID” 

appear as two dif-

ferent com-

mands to a 

system that 

requires case-

sensitive informa-

tion.

Figure 16:  The Invalid Password Window

12. If any notices were received  since the last  login , a m essage is d isplayed, 

as shown  in  Figure 17. For  m ore in form ation  about  viewing not ices, see 

the sect ion  “Reviewing DOJ  Notices” on  page 65.

Figure 17:  The Notices Received Window

13. When  you successfu lly connect  to the DROS En try  Sy stem , the DROS 

Entry System window appears, as shown  in  Figure 18 . 
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Figure 18:  The DROS Entry System Window

This window enables you to choose the following funct ion s:

Screen Option Description

Handgun Dealer Sale Used to enter a Dealer Sale transaction for a handgun. See 

“Entering a Handgun Dealer Sale Transaction” on page 35.

Long Gun Dealer Sale Used to enter a Dealer Sale transaction for a long gun. See 

“Entering a Long Gun Dealer Sale Transaction” on page 46.

Peace Officer Used to enter a Peace Officer transaction for either a 

handgun or a long gun. See “Entering a Peace Officer 

Transaction” on page 48.

Curio/Relic/Olympic 

Pistol/Exempt

Used to enter a Curio, Relic, Olympic Pistol or Exempt 

transaction for either a handgun or a long gun. See 

“Entering a Curio, Relic, Olympic or Exempt Transaction” on 

page 52.

Private Transfer Used to enter a Private Party Transfer transaction for either 

a handgun or a long gun. See “Entering a Private Party, 

Loan or Pawn Transaction” on page 56.

Review, Correct or 

Cancel

Used to review and/or print a previously entered DROS, 

Bulletin or Notice. It is also used to correct or cancel a 

DROS. See “Reviewing a Previously Entered DROS” on 

page 59.

Loan Used to enter a Loan transaction for either a handgun or a 

long gun. See “Entering a Curio, Relic, Olympic or Exempt 

Transaction” on page 52.
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Pawn/Consign Rtn Used to enter a Pawn transaction for either a handgun or a 

long gun. See “Entering a Curio, Relic, Olympic or Exempt 

Transaction” on page 52.

Help Used to access the Help function, which contains a system 

overview of DROS Entry System, Troubleshooting Tips and 

a list of Frequently Asked Questions.

Logoff Used to exit from the DROS Entry System.

Screen Option Description
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Changing a Master or Secondary Password

Use the followin g in struct ion s to change the password that  is used  to log in to the 

DROS En try  Applicat ion . There are two types of passwords that  can  be changed: 

m aster  and secondary. The m aster  password is a un ique password used by a 

dealer . The secon dary password is used  by all salespeople working for  the dealer .

NOTE: Only an 

authorized user 

with a master 

password can 

change a master 

or secondary 

password.

When  changing a password, it  can  be helpful to create a password that  can  be 

easily rem em bered  by you. However , do not  use a com m on  word or  phrase that  

could  be easily guessed by an  unauthor ized  user  t ryin g to gain  access to the 

DROS En try  Applicat ion . Also, never  wr ite your  password down  and leave it  

where unauthor ized users have access to it .

To Change a Password

1. Begin  logging in to the applicat ion , stopping when  the DROS Entry 

System Login window appears, as shown  in  Figure 19. For  in struct ions, 

see “Logging in to the DROS En try System ” on  page 21.

Figure 19:  The DROS Entry System Login Window

2. Click Change Password. The Change Password window appears, as 

shown  in  Figure 20 .

Figure 20:  Change Password Window
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3. En ter  your  Dealer ID and Current Master Password in  the fields 

provided.

TIP: If you have 

forgotten your 

password, click 

Forgot your 

Password and 

call the number 

listed in window 

that displays.

4. Select  the type of password you are changing by select in g the Master or  

Secondary opt ion .

5. En ter  the new m aster  or  secondary password in  the New Password field .

The new password  m ust  con form  to the followin g specificat ion s:

• At least  six characters in  length .

• Con tain  at  least  one uppercase character  (A, B, C, etc.).

• Con tain  at  least  one lowercase character  (a, b, c, etc.).

• Con tain  at  least  one num ber  (1, 2, 3, etc.).

6 . En ter  the new password again  in  the Confirm Password field

7. Click Change Password. The new password is saved and the applicat ion  

return s to the DROS Entry System Login window.

8 . If necessary, con t inue logging in to the DROS En try  Application  usin g 

the new password. For  in struct ions, see “To Log In to the Applicat ion ” on  

page 21.
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3. Processing a DROS
This chapter  explain s how to use a com puter  in  con junct ion  with  the In ternet  to 

en ter  and t ransm it  in form ation  required  to per form  a background eligibility 

check for  a firearm  purchaser .

The followin g topics are in cluded in  th is chapter :

• “Im por tan t  In form ation” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 30

• “Read Me First” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 31

• “En ter in g a H andgun  Dealer  Sale Transact ion” . . . . . . . . . . . . . .  page 35

• “Previewing a DROS”. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 42

• “Sending the DROS to the DOJ ” . . . . . . . . . . . . . . . . . . . . . . . . . .  page 43

• “En ter ing a Long Gun  Dealer  Sale Transact ion”  . . . . . . . . . . . . .  page 46

• “En ter ing a Peace Officer  Transact ion”  . . . . . . . . . . . . . . . . . . . .  page 48

• “En ter in g a Cur io, Relic, Olym pic or  Exem pt Transact ion” . . . . .  page 52

• “En ter ing a Pr ivate Par ty, Loan  or  Pawn  Transact ion”  . . . . . . . .  page 56

• “Reviewin g a Previously En tered DROS” . . . . . . . . . . . . . . . . . . .  page 59

• “Correct ing a DROS” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 62

• “Canceling a DROS” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 64

• “Reviewing DOJ  Notices”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 65

• “Reviewing DOJ  Bullet in s”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 74

• “Accessing the Help Funct ion”  . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 76

• “Logging Off from  the DROS En try System ”  . . . . . . . . . . . . . . . .  page 77
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Important Information

The Read Me First sect ion  that  follows provides im por tan t  in form ation  that  

explain s how to en ter  data in to the DROS En try  Sy stem  windows and the 

standards used th roughout  the system . It  provides basic in form ation  you will 

find  helpful, par t icular ly if you are n ot  fam iliar  with  the use of a com puter . 

Followin g th is topic is a ser ies of sect ions explain ing how to access the DROS 

En try  Sy stem , as well as how to use the DROS En try System  to perform  a var iety 

of funct ions.
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Read Me First

This sect ion  explain s how to navigate, recogn ize drop-down  m enus, and en ter  

in form ation  in  the DROS En try  Sy stem . I t  also explain s how to obtain  a Dealer  

ID and Password.

Receiving a Dealer ID and Password

A Dealer  ID and Password are required  to log in to the DROS En try System  and 

process a DROS using the In tern et  system .

TIP: Have your 

CFD ready before 

calling the ser-

vice center.

Dealer  IDs and Passwords are obtain ed from  the DROS Service Cen ter  by callin g 

1-800-974-3767. A valid  Californ ia Firearm  Dealer  (CFD) num ber  is required  to 

receive a Dealer  ID and Password.

Moving Around the DROS Entry System

Moving from  field  to field  is easy and consisten t  th roughout  the DROS En try 

System . 

The following list  provides in form ation  about  m oving around in  the DROS En try 

system :

• A field  is a box in to which  you can  en ter  in form ation .

• Press the Tab key to m ove in  a forward d irect ion  (from  left  to r igh t , top 

to bot tom ) between  fields. Or  use the m ouse to select  a field .

• H old down  the Shift key and press the Tab key to m ove in  a backward 

direct ion  (from  r igh t  to left , bot tom  to top) between  fields. Or  use the 

m ouse to select  a field .

• Press the Delete or  Backspace keys to erase an  en try from  a field .

• Click the ar row button s ( ) next  to fields to display a drop-down  m enu 

of possible field  select ions.

• Use the m ouse to select  drop-down  m enu opt ions an d access fields. 

Whenever  in struct ions refer  to pressing a “key” they are refer r ing to a 

key on  the keyboard .
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Working with Fields and Drop-Down Menus

Som e fields allow in form at ion  to be in to the field . If a th in  flash in g bar  (refer red  

to as a cursor ) d isplays in  a h igh ligh ted  field , data can  be typed in .

Other  fields have a “drop-down  m enu,” which  is a list  of pre-defined data opt ions 

for  use in  the field . Fields with  a drop-down  m enu have a sm all ar row ( ) on  the 

r igh t  side of the field . Once the ar row is clicked, a list  of opt ion s is d isplayed, 

sim ilar  to Figure 21.

Figure 21:  Example of a Drop-Down Menu

There are two m ethods that  can  be used to select  an  opt ion  from  a drop-down  

m en u.

They are:

• Use the m ouse to select  the ar row ( ) and scroll th rough  the possible 

opt ions. Click on  an  opt ion  to select  the value and populate the field . 

Press the Tab key to m ove to the next  field  (or  select  the field  with  your  

m ouse).

Or

• Begin  typing the nam e of the option  in  the field . The system  displays the 

fir st  option  from  the list  m atch ing the let ters you typed. Keep in  m ind 

that  the m ore specific your  text , the m ore closely the selected  opt ion  

m atches your  cr iter ia. Once the cor rect  opt ion  d isp lays in  the field , press 

the Tab key to m ove to the next  field  (or  select  the field  with  your  

m ouse).
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Using Help

A var iety of “Help” opt ions are available to assist  with  the DROS en try process.

The opt ions are:

• A system  overview and t roubleshooting t ips are accessed by select in g the 

Help but ton  from  the DROS Entry System window (or  from  the Main 

Menu before logging in ).

• Frequen t ly Asked Quest ions (FAQ’s) are accessed  by select ing the 

Frequently Asked Questions opt ion  from  the DROS Entry System 

window (or  from  the Main Menu before logging in ).

• In it ial Set  Up and H ardware/ Software Requirem en ts help  text  is 

accessed by clicking the Setup Help opt ion  on  the Main Menu (before 

logging in ). The Hardware/ Software Requirem en ts help  text  is can  also 

be accessed by clicking the System Requirements button  on  the Main 

Menu (shown  in  Figure 14 on  page 23).

• Quick Reference help  text  is accessed by clicking the Quick Reference 

Sheet option  on  the Main Menu (before logging in ).

• A PDF version  of the User  Man ual is accessed by clicking the DROS 

System User Manual (PDF) opt ion  on  the Main Menu.

• A PDF version  of the DROS En try In stallat ion  m anual is accessed by 

clicking the DROS System Installation Manual (PDF) opt ion  on  the 

Main Menu.

• Online H elp is accessed by clicking the Help but ton  in  the Review DROS 

for Submitted Application screen .

• Another  help  opt ion  is the Troubleshooting Tips chapter  in  th is m anual. 

See “Troubleshooting Tips” on  page 79.

Using the Status Bar

The Status Bar (Figure 22) is located at  the bot tom  of DROS En try  Sy stem  

windows. The DROS En try  Sy stem  uses th is area to com m unicate with  users. 

Each  t im e a field  is h igh lighted , the left  side of the Status Bar  d isplays a br ief 

descr ipt ion  of the field . The Status Bar  also d isp lays whether  the field  type is 

Mandatory or  Optional. 

Figure 22:  The Status Bar

Description of Selected Field Field Type Current Date Current Time
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Printing a CA Firearm Dealer Billing Enrollment Form

This sect ion  descr ibes how to access an d pr in t  a Californ ia Firearm  Dealer  

Billing En rollm en t  Form . This form  m ust  be filled  out  an d returned to Ver izon  

Business to establish  a billing accoun t  in  the DOJ  DROS system .

To Print an Enrollment Form

1. Click the California Firearm Dealer Billing Enrollment Form lin k in  the 

DROS Entry System window (shown  in  Figure 14 on  page 23). An  

en rollm en t  form  appears, as shown  in  Figure 23.

Figure 23:  The California Firearm Dealing Billing Enrollment Form

2. Choose File > Print from  the m enu bar  to pr in t  the form .

3. Click the X but ton  ( ) to exit  the en rollm en t form  screen .
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Entering a Handgun Dealer Sale Transaction

This sect ion  explain s the steps required  to en ter  a new DROS for  a dealer  sale of 

a handgun . The process begins at  the DROS Entry System window. Th is window 

is shown  in  Figure 18  on  page 25.

This win dow is an  In tern et-based DROS worksheet . The window has been  

custom ized so that  on ly the sect ions that  per tain  to a Handgun  Dealer  Sale 

t ransact ion  are enabled: DROS Information, Revolver/Pistol Information and 

Purchaser Information. Because the en t ire worksheet  cann ot  be seen  at  one 

t im e, it  is d ivided  in to th ree tabbed screen s.

To Enter a Handgun Dealer Sale Transaction

1. From  the DROS Entry System win dow (Figure 18  on  page 25), select  the 

Handgun Dealer Sale but ton . The HandGun Sale window appears, as 

shown  in  Figure 24.

Figure 24:  The HandGun Sale Window

The Status Bar at  the bot tom  of the window prom pts you with  specific 

in form ation  about  a selected  field , and lets you know whether  the field  is 

Mandatory or  Optional.
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TIP: If you select 

the CFD (Califor-

nia Firearms 

Dealer) Number 

exemption, you 

must enter the 

Dealer ID number 

in the CFD Num-

ber field. If you 

select the Special 

Weapons Permit 

exemption, you 

must enter the 

permit number in 

the Special 

Weapons Permit 

Number field.

By default , the Gun Purchase Indicator field  is set  to 1. You cannot  edit  

th is field  on  the screen . H owever , on ce you fin ish  en ter ing in form ation  

for  the in it ial DROS, you can  en ter  in form ation  for  addit ional handguns 

providing the purchaser  is exem pt  from  the “on ly one handgun  with in  30  

days” statu tory restr ict ion .

2. The Gun Show Sale field  is h igh ligh ted . Click the  but ton  in  th is field  

and select  Yes or  No from  the drop-down  m enu.

3. Press the Tab key (or  use the m ouse to select  the appropr iate field) to 

m ove to the fir st  field  in  the Waiting Period Exemptions sect ion .

The Waiting Period Exemptions sect ion  is used to select  a type of 

exem ption  for  purchasers with  proof of statu tory exem ptions from  the 

wait ing per iod.

4. Select  an  exem ption  type from  the drop-down  m enu, if applicable.

5. Press the Tab key to m ove to the fir st  field  in  the Revolver/Pistol window.

6. Proceed to the sect ion  “En ter ing Revolver / Pistol In form ation” on  

page 37.
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Entering Revolver/Pistol Information

This sect ion  descr ibes the process for  using the Revolver/Pistol tab (Figure 25) 

to en ter  in form ation  about  the firearm  being purchased/ sold . Th is process is the 

sam e for  each  type of firearm  that  requires revolver / pistol in form ation .

Figure 25:  Revolver/Pistol Tab Selected

Depending on  the type of sale and in form ation  en tered , som e fields m ay be 

grayed out . You cannot  en ter  in form ation  in to a field  that  is grayed out .

The following list  provides in form ation  about  the fields:

• The Certified Guns field  is a  required field  used to select  the revolver /

pistol type from  a drop-down  m enu  of opt ions. The opt ions include 

in form ation  about  the m ake, m ode, type, caliber  and bar rel len gth  of the 

handgun .
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NOTE: For more 

information, a 

current roster of 

handguns certi-

fied for sale is 

provided on the 

DOJ website at 

http://

caag.state.ca.us

/firearms/. From 

the DOJ website, 

click the Roster 

of Handguns 

Certified for 

Sale link.

• The Make, Model, Type, Caliber, Barrel Length and  Units fields are 

autom atically filled on ce a cer t ified  gun  type is chosen .

• The handgun’s ser ial num bers are en tered  in  the Serial Number and  

Other Number fields. The Other Number field  is opt ional and used if 

there is another  num ber  stam ped on  the firearm  that  is not  par t  of the 

ser ial num ber .

• If you select  Other Handgun as the Type (handgun  type), you m ust  en ter  

the specific kind of handgun  in  the Comments field  at  the bot tom  of the 

win dow.

• The Barrel Length m ay be en tered  as a decim al or  a fract ion . For  

exam ple, if the len gth  is 10  and a half inches, you can  en ter  either  10.5 or  

10 (space) 1/2. The system  conver ts the en try to a decim al if it  was 

en tered  as a fract ion .

• The Origin of Gun field  refers to the coun try in  which  the han dgun  was 

m ade.

• The New Gun field  is used  to select  whether  the gun  is new or  used.

• The Comments field  is used for  rem arks per tain in g to the handgun . This 

field  accepts up to 15 characters, including spaces.

To Enter Revolver/Pistol Information

1. In  the Certified Guns field , click the  but ton  an d select  a gun  type from  

the drop-down  m enu. The Make, Model, Type, Caliber, Barrel Length and 

Units fields are autom atically filled  on ce a cer t ified  gun  type is chosen .

NOTE: Use the 

Tab key or the 

mouse to move to 

each field, then 

type the 

requested infor-

mation or select 

the appropriate 

option from each 

drop-down menu. 

2. En ter  the revolver / pistol in form ation , use the m ouse to select  and access 

the Purchaser window.

3. Proceed to the sect ion  “En ter ing Purchaser  In form ation” on  page 39.
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Entering Purchaser Information

This sect ion  descr ibes the process for  using the Purchaser tab (Figure 26) to 

en ter  in form ation  about  the person  receiving the firearm . This process is the 

sam e for  each  type of firearm  th at  requires purchaser  in form ation .

Figure 26:  Purchaser Tab Selected

In form ation  such  as the purchaser ’s nam e and address is en tered  by scann ing 

their  dr iver ’s license or  iden t ificat ion  th rough  a m ag str ipe reader . Once the 

license or  iden tificat ion  is scanned, in form ation  can  be m odified  if necessary.

Following are t ips for  en ter in g a purchaser ’s in form ation :

• Do not  put  a per iod in  an y of the n am e fields. For  exam ple, if you en ter  a 

m iddle in it ial, en ter  the in it ial on ly and do not  put  a per iod after  it .

NOTE: Depend-

ing on the type of 

sale and informa-

tion entered, 

some fields may 

be grayed out.

• When  en ter ing the date of bir th , use slashes (/ ) to separate the m on th , 

day and year . For  exam ple J anuary 5, 1942 should  be en tered  as 01/05/

1942 (m m / dd/ yyyy).

• When  en ter ing the purchaser ’s weigh t , the num ber  should  be en tered  as 

th ree characters. For  exam ple, if the purchaser  weighs 98  pounds, the 

weigh t  should  be en tered  as 098.
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• The HSC Exemption Code field  refers to the H andgun  Safety Cer t ificate 

num ber . You m ust  en ter  th is num ber  in  th is field  or  select  an  opt ion  

from  the HSC Exemption Code drop-down  m enu.

• If No is selected  from  the United States Citizen drop-down  list , a  Country 

of Citizenship m ust  be selected  and an  Alien Registration # or  I-94 # m ust  

be en tered  in  the corresponding fields. The Alien Registration # num ber  

can  be found on  the purchaser ’s Perm anen t  Residen t  Card  (Green  Card). 

The I-94 # can  be foun d on  the purchaser’s I-94 Arr ival/ Depar ture Card. 

The Registration # field  accepts up to 10  characters. The I-94 # field  

accepts up to 11 characters.

• Select  Yes or  No for  each  of the four  quest ion s listed at  the bottom  of the 

window based on  the purchaser ’s responses.

• The Comments field  enables you to en ter  rem arks per tain ing to the 

DROS. This field  accepts up to 35 characters, in cluding space.

To Enter Purchaser Information

1. With  the Purchaser tab selected , press the F5 key to d isplay the Read 

Purchaser California ID or DMV Card window, as shown  in  Figure 27. 

This win dow m ust  be d isplayed before scann ing the purchaser’s dr iver ’s 

license or  iden t ificat ion  th rough  a m ag str ipe reader .

NOTE: To exit the 

window without 

scanning the 

driver’s license or 

identification, 

press the Esc 

key.

Figure 27:  The Read Purchaser California ID or DMV Card Window

NOTE: Each field 

containing the 

purchaser’s infor-

mation can be 

modified. That 

means that you 

can update the 

address in the 

window if the pur-

chaser has 

moved since the 

driver’s license or 

identification was 

issued.

2. Using the m ag str ipe reader , scan  the purchaser ’s dr iver ’s license or  

iden t ificat ion . The d irect ion  to scan  the card  is pr in ted on  the card 

reader .

The progress bar  on  the Read Purchaser California ID or DMV Card 

win dow indicates that  the applicat ion  is retr ieving the purchaser ’s 

in form ation  from  the card . When  the in form ation  has been  retr ieved, the 

win dow closes and the appropr iate fields are populated.

If the purchaser ’s dr iver ’s license or  iden t ificat ion  will n ot  scan , their  

in form at ion  can  be en tered  m anually. But  fir st , check the 

troubleshoot in g sect ion  on  page 79 for  t ips on  get t ing the dr iver ’s license 

or  iden t ificat ion  to scan .

3. If the Read Purchaser California ID or DMV Card win dow does not  close 

autom atically after  the fields are populated , press the ESC key on  the 

keyboard  to close the window.
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4. Select  whether  the purchaser  is a cit izen  from  the United States Citizen 

drop-down  list . If No is selected , a Country of Citizenship m ust  be 

selected  and an  Alien Registration # or  I-94 # m ust be en tered  in  the 

cor respon din g fields. These n um bers can  be found on  the purchaser ’s 

Perm anen t  Residen t  Card  (Green  Card) or  I-94 Arr ival/ Depar ture Card .

5. Use the Tab key (or  the m ouse) to m ove to each  field  and either  type the 

requested  in form ation  or  select  the appropr iate opt ion  from  each  drop-

down  m enu.

6. Select  Yes or  No for  each  of the four  quest ions at  the bot tom  of the 

window based on  the purchaser ’s response.

7. Preview the DROS by proceedin g to the sect ion  “Previewing a DROS” on  

page 42.

Or

Subm it  the DROS by proceeding to the sect ion  “Sending the DROS to the 

DOJ ” on  page 43.
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Previewing a DROS

Once all in form ation  has been  en tered  for  a DROS, you can  preview it  before 

subm it t ing it  to the DOJ . Th is gives you a chance to pr in t  and review a DROS and 

m ake an y necessary cor rect ion s to the in form ation  before subm it t ing it .

NOTE: A DROS 

is not complete 

and has not been 

sent to the DOJ 

until the Submit 

button has been 

clicked. See the 

section “Sending 

the DROS to the 

DOJ” on page 43 

for more informa-

tion on submitting 

a DROS.

To Preview a DROS

1. Once you have en tered  all of the DROS in form ation , click the Preview 

but ton .

If all required  fields have not  been  com pleted , a m essage window 

indicates which  fields require m ore in form ation .

If all en tered  in form ation  is com plete, the Review DROS for Submitted 

Application screen  appears, sim ilar  to Figure 28 .

It  is im por tan t  to note that  a DROS Number is not  assigned to a preview 

DROS. A DROS Num ber  is on ly assigned when  the DROS is subm itted  to 

the DOJ . See the sect ion  “Sen din g the DROS to the DOJ ” on  page 43 for  

m ore in form ation  on  subm it t ing a DROS.

Figure 28:  The Review DROS for Submitted Application Window

2. Click the Print but ton  to pr in t  the DROS preview. A DROS can  also be 

pr in ted  by pressing Ctrl + P on  the keyboard .

3. Click the Close but ton  to return  to the DROS Entry System win dow.
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Sending the DROS to the DOJ

When  you have com pleted an d reviewed all of the in form ation  for  the DROS, you 

are ready to send it  to the DOJ . Once the DROS is sen t  to the DOJ , a DROS 

Num ber  is assigned.

TIP: If a mes-

sage box 

appears, a man-

datory field may 

require input. The 

message may 

also indicate that 

the information 

entered may 

have failed the 

validation check. 

Click the Ok but-

ton or press the 

Enter key to 

close the mes-

sage box. Correct 

the problem and 

click the Submit 

button again.

To Send the DROS to the DOJ

1. Click the Submit but ton  (shown  in  Figure 26 on  page 39) to send th is 

DROS to the DOJ .

The system  checks the in form ation  you have en tered to en sure that  all 

m andatory fields are com plete and that  the in form ation  has been  en tered  

proper ly. If a quest ionable en try is detected , a pop-up m essage box 

appears with  d irect ions or  com m en ts, an d the cursor  is p laced in  the field  

in  quest ion .

2. When  all of the in form ation  has been  en tered  proper ly, the t ransm ission  

process begins.
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Receiving a DROS Number

When  the t ransm ission  process is fin ished, a com pleted  copy of the DROS (with  

a DROS n um ber) d isplays on  the Review DROS for Submitted Application 

screen , as shown  in  Figure 29. 

Figure 29:  The Review DROS for Submitted Application Window

To Print the DROS

1. Click the Print bu t ton  to pr in t  the DROS. The pr in t  funct ion  is not  

autom atic, you m ust  click the Print but ton  to pr in t  the DROS. A DROS 

can  also be pr in ted  by pressing Ctrl + P on  the keyboard .

The purchaser  and salesperson  m ust  sign  the pr in ted  DROS.

The Delivery Date/Time and Dealer Information m ust  be m anually 

en tered  on  the pr in ted  DROS.

2. Click the Close but ton  to return  to the DROS Entry System window.
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Entering Additional Handgun Purchases

The Additional Handgun Purchase bu t ton  displays at  the bot tom  of the 

window when  the com pleted  DROS appears when  selling m ult ip le handguns to 

the sam e purchaser . Addit ional handguns can  be purchased on ly if the purchaser  

is exem pt from  the “on ly one handgun  with in  30  days” statu tory restr ict ion .

The following in struct ions descr ibe how to en ter  an other  DROS for  th is 

purchaser .

To Enter Additional Handgun Purchases

1. Click the Additional Handgun Purchase but ton . The Revolver/Pistol 

window appears. All other  in form ation  from  the or iginal DROS is copied 

to the new record.

2. En ter  in form ation  about  the firearm  for  the next  handgun  purchase.

3. Click the Preview but ton  to review the DROS before subm it t ing it  to the 

DOJ . For  m ore in form ation  on  previewing a DROS, see the sect ion  

“Previewin g a DROS” on  page 42.

4. Click the Submit bu t ton  to send the addit ional DROS to the DOJ .

5. Repeat  these steps for  addit ional handguns, or  click the Close but ton  to 

fin ish .
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Entering a Long Gun Dealer Sale Transaction

This sect ion  explain s how to en ter  a DROS for  the sale of one or  m ore long guns. 

I t  begin s at  the DROS Entry System window. This window is shown  in  Figure 18  

on  page 25.

This is an  In ternet-based DROS worksheet  that  has been  custom ized so that  on ly 

the sect ions that  per tain  to a Dealer  Sale for  a Long Gun  transact ion  are enabled: 

DROS Information and Purchaser Information. Because th is t ransaction  does 

not  per tain  to a handgun , the Revolver/Pistol Information win dow is d isabled.

To Enter a Long Gun Dealer Sale Transaction

1. In  the DROS Entry System window (Figure 18  on  page 25), click the 

Long Gun Dealer Sale but ton .

The Long Gun Sale window appears, as shown  in  Figure 30 .

Figure 30:  The Long Gun Sale Window

2. En ter  the num ber  of long guns being purchased in  the Firearm Quantity 

field . Then  specify whether  the sale or igin ated at  a gun  show.

3. Choose whether  the firearm  was purchased at  a gun  show from  the Gun 

Show Sale drop-down  m enu.
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4. Com plete the Waiting Period Exemptions sect ion  then  select  the 

Purchaser tab.

5. Com plete the Purchaser tab fields. The process for  en ter ing the 

purchaser ’s in form at ion  is detailed  in  the sect ion  “En ter ing Purchaser  

In form ation” on  page 39.

6. Click the Preview but ton  to review the DROS before subm it t ing it  to the 

DOJ . For  m ore in form ation  on  previewing a DROS, see the sect ion  

“Previewin g a DROS” on  page 42.

7. Click the Submit bu t ton  to send the DROS to the DOJ .

When  the t ransm ission  process is com plete, a copy of the DROS with  a 

DROS num ber  appears on  the screen .

For  m ore in form ation  on  subm it t ing a DROS, see the sect ion  “Sending 

the DROS to the DOJ ” on  page 43.

NOTE: DROS can 

also be printed by 

pressing Ctrl and 

P on the key-

board.

8 . Click the Print bu t ton  to pr in t  the DROS. The pr in t  funct ion  is not  

autom atic, you m ust  click the Print but ton  to pr in t  the DROS.

The Delivery Date/Time and Dealer Information m ust  be m anually 

en tered  on  the pr in ted  DROS.

9. Click the Close but ton  to return  to the DROS Entry System window.
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Entering a Peace Officer Transaction

This sect ion  explain s the steps required  to en ter  a n ew DROS for  a peace officer  

t ransact ion . The process begins at  the DROS Entry System window. This window 

is shown  in  Figure 18  on  page 25.

The Non-Roster Peace Officer (Figure 31) window is an  In ternet-based  DROS 

worksheet . The window has been  custom ized so that  on ly the sect ions that  

per tain  to a non -roster  peace officer  t ransact ion  are enabled: DROS 

Information, Revolver/Pistol Information and Purchaser Information. 

Because the en t ire worksheet  cannot  be seen  at  one t im e, it  is d ivided in to th ree 

tabbed screens.

To Enter a Peace Officer Transaction

1. From  the DROS Entry System win dow (Figure 18  on  page 25), click the 

Peace Officer but ton . The Non-Roster  Peace Officer  window appears, as 

shown  in  Figure 31.

Figure 31:  The Non-Roster Peace Officer Window

The Status Bar at  the bot tom  of the window prom pts you with  specific 

in form ation  about  a selected  field  and lets you know whether  the field  is 

Mandatory or  Optional.

By default , the Gun Purchase Indicator field  is set  to 1. You cannot  edit  

th is field  on  the screen . H owever , on ce you fin ish  en ter ing in form ation  
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for  the in it ial DROS, you can  en ter  in form ation  for  addit ional handguns, 

providing the purchaser  is exem pt  from  the “on ly one handgun  with in  30  

days” statu tory restr ict ion .

2. The Gun Show Sale field  is h igh ligh ted. Click the down  ar row button  in  

th is field  and select  Yes or  No from  the drop-down  m enu.

3. Press the Tab key (or  use the m ouse to select  the appropr iate field) to 

m ove to the fir st  field  in  the Waiting Period Exemptions sect ion .

TIP: If you select 

the CFD Num-

ber exemption, 

you must enter 

the Dealer ID 

number in the 

CFD Number 

field. If you select 

the Special 

Weapons Per-

mit exemption, 

you must enter 

the permit num-

ber in the Special 

Weapons Per-

mit Number field.

The Waiting Period Exemptions sect ion  is used to select  a type of 

exem ption  for  purchasers with  proof of statu tory exem ptions from  the 

wait ing per iod.

4. Select  an  exem ption  type from  the drop-down  m enu, if applicable.

5. Press the Tab key to m ove to the fir st  field  in  the Revolver/Pistol window.

6. Proceed to the sect ion  “En ter ing Revolver / Pistol In form ation” on  

page 50 .
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Entering Revolver/Pistol Information

This sect ion  explain s the steps required  to en ter  revolver / pistol in form ation  

specific to the handgun  for  a peace officer  t ransact ion . Th is in form ation  is 

en tered  in  the Revolver/Pistol tab, as shown  in  Figure 32

Figure 32:  Revolver/Pistol Tab Selected

The Non-Roster Peace Officer (Figure 32) window is an  In tern et-based DROS 

worksheet .

The following fields descr ibe the fields in  th is screen :

• The Other Number field  is opt ional and used if there is another  num ber  

stam ped on  the firearm  that  is not  par t  of the ser ial num ber .

• If you select  Other Handgun as the Type (handgun  type), you m ust  en ter  

the specific kind of handgun  in  the Comments field  at  the bot tom  of the 

win dow.

• The Barrel Length m ay be en tered  as a decim al or  a fract ion . For  

exam ple, if the len gth  is 10  and a half inches, you can  en ter  either  10.5 or  

10 (space) 1/2. The system  conver ts the en try to a decim al if it  was 

en tered  as a fract ion .

• The Origin of Gun field  refers to the coun try in  which  the han dgun  was 

m ade.

• The Comments field  is used for  rem arks per tain in g to the handgun  an d 

accepts up to 15 characters, including spaces.
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To Enter Revolver/Pistol Information

1. En ter  the revolver / pistol in form ation , use the m ouse to select  and access 

the Purchaser window.

NOTE: Use the 

Tab key or the 

mouse to move to 

each field. Either 

type the 

requested infor-

mation or select 

the appropriate 

option from each 

drop-down menu.

2. Com plete the Purchaser window fields. The process for  en ter ing the 

purchaser ’s in form at ion  is detailed  in  the sect ion  “En ter ing Purchaser  

In form ation” on  page 39.

3. Click the Preview but ton  to review the DROS before subm it t ing it  to the 

DOJ . For  m ore in form ation  on  previewing a DROS, see the sect ion  

“Previewin g a DROS” on  page 42.

4. Click the Submit bu t ton  to send the DROS to the DOJ .

When  the t ransm ission  process is com plete, a copy of the DROS with  a 

DROS num ber  appears on  the screen .

For  m ore in form ation  on  subm it t ing a DROS, see the sect ion  “Sending 

the DROS to the DOJ ” on  page 43.

NOTE: DROS can 

also be printed by 

pressing Ctrl and 

P on the key-

board.

5. Click the Print bu t ton  to pr in t  the DROS. The pr in t  funct ion  is not  

autom atic, you m ust  click the Print but ton  to pr in t  the DROS.

The Delivery Date/Time and Dealer Information m ust  be m anually 

en tered  on  the pr in ted  DROS.

6. Click the Close but ton  to return  to the DROS Entry System win dow.
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Entering a Curio, Relic, Olympic or Exempt 
Transaction

This sect ion  explains the steps required to en ter  a new DROS for  a cur io, relic, 

Olym pic pistol or  exem pt t ransact ion . The process begin s at  the DROS Entry 

System window. This win dow is shown  in  Figure 18  on  page 25.

The Curio/Relic/Olympic Pistol/Exempt window is an  In ternet-based DROS 

worksheet . The window has been  custom ized so that  on ly the sect ions that  

per tain  to a Cur io/ Relic/ Olym pic Pistol/ Exem pt t ransact ion  are enabled: DROS 

Information, Revolver/Pistol Information and Purchaser Information. 

Because the en t ire worksheet  cannot  be seen  at  one t im e, it  is d ivided in to th ree 

tabbed screens.

To Enter a Curio, Relic, Olympic Pistol or Exempt Transaction

1. From  the DROS Entry System window, click the Curio/Relic/Olympic 

Pistol/Exempt button . The Curio/Relic/Olympic Pistol/Exempt window 

appears, as shown  in  Figure 33.

Figure 33:  The Curio/Relic/Olympic Pistol/Exempt Window

The Status Bar at  the bot tom  of the window prom pts you with  specific 

in form ation  about  a selected  field  and lets you know whether  the field  is 

Mandatory or  Optional.

By default , the Gun Purchase Indicator field  is set  to 1. You cannot  edit  

th is field  on  the screen . H owever , on ce you fin ish  en ter ing in form ation  
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for  the in it ial DROS, you can  en ter  in form ation  for  addit ional handguns 

providing the purchaser  is exem pt from  the “on ly one handgun  purchase 

with in  30  days” statu tory restr ict ion .

The Gun Show Sale field  is h igh ligh ted , indicat ing the posit ion  of your  

cursor . 

2. Select  Yes or  No from  the drop-down  m enu.

3. Press the Tab key (or  use the m ouse to select  the appropr iate field) to 

m ove to the fir st  field  in  the Waiting Period Exemptions sect ion .

TIP: If you select 

the CFD Num-

ber exemption, 

you must enter 

the Dealer ID 

number in the 

CFD Number 

field. If you select 

the Special 

Weapons Per-

mit exemption, 

you must enter 

the permit num-

ber in the Special 

Weapons Per-

mit Number field.

The Waiting Period Exemptions sect ion  is used to select  a type of 

exem ption  for  purchasers with  proof of statu tory exem ptions from  the 

wait ing per iod.

4. Select  an  exem ption  type from  the drop-down  m enu, if applicable.

5. Press the Tab key to m ove to the fir st  field  in  the Revolver/Pistol window.

6. Proceed to the sect ion  “En ter ing Revolver / Pistol In form ation” on  

page 54.
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Entering Revolver/Pistol Information

This sect ion  explain s the steps required  to en ter  revolver / pistol in form ation  

specific to a Cur io/ Relic/ Olym pic Pistol/ Exem pt t ransact ion . Th is in form ation  is 

en tered  in  the Revolver/Pistol tab, as shown  in  Figure 34.

Figure 34:  Revolver/Pistol Tab Selected

The Curio/Relic/Olympic Pistol/Exempt window is an  In ternet-based DROS 

worksheet .

The following list  descr ibes the fields found in  th is screen :

• The Other Number field  is opt ion al and is used if there is another  num ber  

stam ped on  the firearm  that  is not  par t  of the ser ial num ber .

• If you select  Other Handgun as the Type (handgun  type), you m ust  en ter  

the specific kind of handgun  in  the Comments field  at  the bot tom  of the 

win dow.

• The Barrel Length m ay be en tered  as a decim al or  a fract ion . For  

exam ple, if the len gth  is 10  and a half inches, you can  en ter  either  10.5 or  

10 (space) 1/2. The system  will conver t  the en try to a decim al if it  was 

or igin ally en tered  as a fract ion .

• The Origin of Gun field  refers to the coun try in  which  the han dgun  was 

m ade.

• The Comments field  is used for  rem arks per tain in g to the handgun . This 

field  accepts up to 15 characters.
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To Enter Revolver/Pistol Information

1. En ter  the revolver / pistol in form ation , use the m ouse to select  and access 

the Purchaser window (or  press the Tab key after  addressing the final 

field  on  the Revolver/Pistol window).

NOTE: Use the 

Tab key or the 

mouse to move to 

each field and 

either type the 

requested infor-

mation or select 

the appropriate 

option from each 

drop-down menu.

2. Com plete the Purchaser window fields. The process for  en ter ing the 

purchaser ’s in form at ion  is detailed  in  the sect ion  “En ter ing Purchaser  

In form ation” on  page 39.

3. Click the Preview but ton  to review the DROS before subm it t ing it  to the 

DOJ . For  m ore in form ation  on  previewing a DROS, see the sect ion  

“Previewin g a DROS” on  page 42.

4. Click the Submit bu t ton  to send the DROS to the DOJ .

When  the t ransm ission  process is com plete, a copy of the DROS with  a 

DROS num ber  appears on  the screen .

For  m ore in form ation  on  subm it t ing a DROS, see the sect ion  “Sending 

the DROS to the DOJ ” on  page 43.

NOTE: DROS can 

also be printed by 

pressing Ctrl + P 

on the keyboard.

5. Click the Print bu t ton  to pr in t  the DROS. The pr in t  funct ion  is not  

autom atic, you m ust  click the Print but ton  to pr in t  the DROS.

The Delivery Date/Time and Dealer Information m ust  be m anually 

en tered  on  the pr in ted  DROS.

6. Click the Close but ton  to return  to the DROS Entry System window.
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Entering a Private Party, Loan or Pawn 
Transaction

A Private Party Transfer refers to the sale or  t ran sfer  of a handgun  or  long gun  

by an  individual who is not  a firearm  dealer . A Loan r efers to the loan  of a 

handgun  or  long gun  between  individuals. A Pawn r efers to the loan ing of m oney 

(with  in terest) to an  individual for  a handgun  or  long gun  left  in  the possession  

of a pawnbroker  un t il redeem ed at  a later  date.

NOTE: Sellers 

with an out-of-

state license are 

not allowed to 

make private 

party transfers.

When  you select  any of these opt ions from  the DROS Entry System window, a 

secondary m enu appears so that  you can  select  the type of firearm .

To Enter a Private Party Transfer, Loan or Pawn Transaction

This procedure begin s at  the DROS Entry System window. This window is shown  

in  Figure 18  on  page 25.

1. Select  the appropr iate option : (Private Party Transfer, Loan or  Pawn). 

To illustrate th is procedure, we are select ing the Private Party Transfer 

opt ion .) A secondary m enu appears (Figure 35) allowin g you to choose 

the type of firearm : han dgun  or  long gun .

Figure 35:  Selecting Firearm Type

2. Select  either  the Handgun or  Long gun but ton .

The In tern et-based DROS worksheet  is custom ized so that  on ly the 

sect ions that  per tain  to a Pr ivate Par ty Transfer  (or  Loan  or  Pawn) are 

en abled: DROS Information, Revolver/Pistol Information (th is sect ion  

on ly d isplays if th is t ran sfer  per tain s to a handgun ), Purchaser 

Information and Seller Information windows are enabled (the Seller  

window is d isabled  for  Pawn  transactions).

3. Com plete the Waiting Period Exemption section, then  tab (or  use your  

m ouse) to access and update the Revolver/Pistol (if applicable), 

Purchaser and Seller windows.
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Seller Information

This sect ion  is used to en ter  in form ation  per tain ing to the person  selling or  

t ransfer r ing the firearm  when  the seller  is not  a firearm  dealer . The seller ’s 

in form ation  is en tered  in to the Seller Information window, shown  in  Figure 36.

Figure 36:  The Seller Information Window

To Enter Seller Information

1. Press the F6 key to br ing up the Read Seller California ID or DMV Card 

window, as shown  in  Figure 37. Th is window m ust  be brought  up before 

you can  scan  the seller ’s dr iver ’s license.

Figure 37:  The Read Seller California ID or DMV Card Window

2. Using the m ag str ipe reader , scan  the seller ’s dr iver ’s licen se or  

iden t ificat ion . The d irect ion  to scan  the card  is pr in ted on  the card 
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reader . To exit  the window without  scann ing the dr iver ’s license or  

iden t ificat ion , press the Esc key.

NOTE: Each field 

containing the 

seller’s informa-

tion can be modi-

fied. That means 

that you can 

update the 

address in the 

window if the 

seller has moved 

since the driver’s 

license or identifi-

cation was 

issued.

The progress bar  on  the Read Seller California ID or DMV Card win dow 

indicates that  the applicat ion  is retr ieving the seller ’s in form ation  from  

the card. When  the in form ation  has been  retr ieved, the win dow closes 

and the appropr iate fields are populated . 

If the seller ’s dr iver ’s licen se or  iden t ificat ion  will n ot  scan , their  

in form at ion  can  be en tered  m anually. But  fir st , check the 

t roubleshoot in g sect ion  beginn ing on  page 79 for  t ips on  get t ing the 

dr iver ’s license to scan .

3. Press the ESC key to close the Read Seller California ID or DMV Card 

win dow.

4. Select  whether  the seller  is a cit izen  from  the United States Citizen drop-

down  list . If No is selected , a Country of Citizenship m ust  be selected  an  

Alien Registration # or  I-94 # m ust  be en tered  in  the corresponding 

fields. The Alien Registration # num ber  can  be found on  the purchaser ’s 

Perm anen t  Residen t  Card  (Green  Card). The I-94 # can  be found on  the 

purchaser ’s I-94 Arr ival/ Depar ture Card . The Registration # field  accepts 

up to 10  characters. The I-94 # field  accepts up to 11 characters.

5. Click the Preview but ton  to review the DROS before subm it t ing it  to the 

DOJ . For  m ore in form ation  on  previewing a DROS, see the sect ion  

“Previewin g a DROS” on  page 42.

6. Click the Submit bu t ton  to send the DROS to the DOJ .

When  the t ransm ission  process is com plete, a copy of the DROS with  a 

DROS num ber  appears on  the screen .

For  m ore in form ation  on  subm it t ing a DROS, see the sect ion  “Sending 

the DROS to the DOJ ” on  page 43.

NOTE: DROS can 

also be printed by 

pressing Ctrl + P 

on the keyboard.

7. Click the Print bu t ton  to pr in t  the DROS. The pr in t  funct ion  is not  

autom atic, you m ust  click the Print but ton  to pr in t  the DROS.

The Delivery Date/Time and Dealer Information m ust  be m anually 

en tered  on  the pr in ted  DROS.

8 . Click the Close but ton  to return  to the DROS Entry System window.
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Reviewing a Previously Entered DROS

This sect ion  explain s how to use the In ternet  to review and/ or  pr in t  a DROS that  

was subm it ted  in  the past  30  days. The process begins at  the DROS Entry 

System window. This window is shown  in  Figure 18  on  page 25.

To Review a Previously Entered DROS

1. From  the DROS Entry System window, click the Review, Correct or 

Cancel but ton . The Review DROS for Submitted Application window 

appears, as shown  in  Figure 38 .

Figure 38:  The Review DROS for Submitted Application Window

The followin g table con tain s descr ipt ions of the but tons found in  the 

Review DROS for Submitted Application win dow: 

Button/field description

Help Enables you to access the Help function, which provides an 

overview of the DROS Entry System, troubleshooting tips 

and a list of Frequently Asked Questions. Click the Help 

button to access this function.

Notices Enables you to display a DOJ notice regarding a DROS that 

was submitted during the past 30 days. Click the Notices 

button to access this function.

Bulletins Enables you to display a DOJ bulletin issued during the 

past 30 days. Click the Bulletins button to access this 

function.
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2. En ter  the n um ber  of days for  which  you wan t  to review DROS in  the Days 

to Review DROS field  and click the Days to Review DROS but ton .

A list  of all DROS processed dur ing the past  selected  num ber  of days is 

d isplayed, sim ilar  to Figure 39.

Figure 39:  List of DROS Processed During Selected Number of Days

Days to Review DROS Enables you to display and review all DROS that have been 

processed during a specific number of days. Enter a review 

period and click the Days to Review DROS button to 

access this function. A DROS reviewed using this function 

cannot be cancelled or modified.

Review Enables you to display and review a DROS that has been 

processed during the past 30 days. Enter the DROS 

number and click the Review button to access this function. 

A DROS reviewed using this function can be cancelled or 

modified.

Setup Enables you to define the print setup for the Help Text, 

Notice, Bulletin or DROS. Click the Setup button to access 

this function.

Print Enables you to print the Help Text, Notice, Bulletin or 

DROS. Click the Print button to access this function.

Close Enables you to close the window and return to the DROS 

Entry System window. Click the Close button to access this 

function.

Button/field description
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3. If a date is d isplayed in  the Corrected colum n  for  a DROS, click the date 

to d isplay an y cor rect ion s that  were m ade to the DROS.

4. If a not ice is d isplayed in  the Notice Type colum n  for  a DROS, click the 

not ice to d isp lay any not ices associated  with  the DROS.

5. To display a DROS, click on  the DROS Number. The DROS is d isplayed, 

sim ilar  to Figure 40 .

DROS that  are reviewed usin g the Days to Review DROS fun ct ion  

cannot  be can celled  or  m odified . To cor rect  a DROS, see the sect ion  

“Correct ing a DROS” on  page 62. To cancel a DROS, see the sect ion  

“Canceling a DROS” on  page 64.

Figure 40:  The Displayed DROS

NOTE: DROS can 

also be printed by 

pressing Ctrl + P 

on the keyboard.

6. Click the Print bu t ton  to pr in t  the DROS. The pr in t  funct ion  is not  

autom atic, you m ust  click the Print but ton  to pr in t  the DROS.

The Delivery Date/Time and Dealer Information m ust  be m anually 

en tered  on  the pr in ted  DROS.

7. Click the Close but ton  to return  to the DROS Entry System window.
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Correcting a DROS

Once a DROS worksheet  has been  subm it ted, on ly one chan ge can  be m ade to the 

DROS. This change can  on ly be m ade to one of the fields in  the Revolver/Pistol 

Information sect ion . In  addit ion , th is change m ust  be m ade dur in g the wait ing 

per iod . After  the wait ing per iod  expires, you m ust  use the Cancellat ion /

Correct ion  form  issued by the DOJ .

To Correct a DROS

This procedure begins at  the DROS Entry System window. Th is window is shown  

in  Figure 18  on  page 25.

1. From  the DROS Entry System window, click the Review, Correct or 

Cancel but ton .

The Review DROS for Submitted Application window appears.

2. En ter  the specific DROS n um ber  in  the DROS Number field .

3. Click the Review but ton .

The selected  DROS appears on  the screen , sim ilar  to Figure 41. 

Figure 41:  The DROS Displayed

4. Click the Correct DROS bu t ton .
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The Correct Handgun window appears, as shown  in  Figure 42. The list  

box on  the left  side of the window con tain s the fields from  the Revolver/

Pistol window sect ion  that  you can  change.

NOTE: Certified 

guns or serial 

numbers can only 

be changed for 

Dealer Sale 

transactions. All 

options other 

than certified 

guns can be 

changed for other 

hand gun sales.

Figure 42:  The Correct Handgun Window

5. Select  the n am e of the field  you wan t to correct .

A cor respon din g field  d isplays on  the r igh t  side of the window so that  you 

can  en ter  the appropr iate in form ation . If the field  con tain s a drop-down  

m enu, the r igh t  side of the field  d isplays with  an  ar row.

NOTE: If you 

attempt to modify 

the same DROS 

again, the appli-

cation displays a 

“DROS Already 

Corrected. No 

Further Correc-

tions Allowed” 

error message.

6. Make the correct ion  by either  typin g the m odificat ion  or  clicking the 

down  ar row and select ing an  opt ion  from  the drop-down  m enu.

If you wan t  to m odify a d ifferen t  DROS or  you decide n ot  to change the 

cur ren t  DROS, click the Cancel but ton  to return  to the Review DROS for 

Submitted Application window. 

7. Click the Send bu tton  to send the cor rected  DROS to the DOJ .

When  the t ransm ission  process is com plete, the DROS n um ber  an d a 

“Corrected  Successfu lly” m essage d isplay on  the Review DROS for 

Submitted Application window.

NOTE: DROS can 

also be printed by 

pressing Ctrl + P 

on the keyboard.

8 . Click the Print bu t ton  to pr in t  the revised  DROS. The pr in t  function  is 

not  autom atic, you m ust  click the Print but ton  to pr in t  the DROS.

The Delivery Date/Time and Dealer Information m ust  be m anually 

en tered  on  the pr in ted  DROS.

9. Click the Close but ton  to return  to the DROS Entry System window.
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Canceling a DROS

You can  cancel a DROS th rough  the DROS En try  Sy stem  as long as it  is with in  

the m andated wait in g per iod . After  th is per iod expires, you m ust  use the 

Cancellat ion / Correct ion  form  issued by the DOJ .

To Cancel a DROS

This procedure begin s at  the DROS Entry System window. This window is shown  

in  Figure 18  on  page 25.

1. From  the DROS Entry System window, click the Review, Correct or 

Cancel but ton .

The Review DROS for Submitted Application window appears (Figure 44 

on  page 65).

2. En ter  the DROS num ber  in  the DROS Number fields then  click the 

Review but ton .

The DROS appears on  the screen .

3. Click the Cancel DROS but ton . A m essage box appears, enabling you to 

con firm  the cancellat ion  of the DROS, as shown  in  Figure 43.

Figure 43:  The Cancel DROS Message Window

4. Click the Yes bu tton  to con firm  an d send the cancellat ion  to the DOJ .   

Or

Click the No but ton  if you do n ot  wan t  to cancel the DROS.

NOTE: If you try 

to cancel the 

same DROS 

again, a “DROS 

is Already Can-

celled” error mes-

sage appears.

When  the t ransm ission  process is com plete, the DROS n um ber  an d a 

“Can celled  Successfully” m essage display on  the screen .

5. Click the Print bu t ton  to pr in t  the cancelled  DROS. The pr in t  function  is 

not  autom atic, you m ust  click the Print bu t ton  to pr in t  the cancelled  

DROS.

6. Click the Close but ton  to return  to the DROS Entry System window.
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Reviewing DOJ Notices

It  is im perat ive that  you review DOJ  notices daily as these n ot ices m ay per tain  to 

den ied, delayed or  rejected  DROS transact ions. As a firearm s dealer , it  is your  

pr im ary responsibility to cancel or  delay the sale of the firearm (s) whenever  you 

are notified by the DOJ  to do so. Th is is necessary to ensure that  proh ibited  

person s do not  im proper ly or  illegally obtain  firearm s. The DROS En try  Sy stem  

applicat ion  gives the opt ion  to review a DOJ  not ice per tain in g to a DROS en tered 

dur ing the past  30  calendar  days. There are seven  DROS notice types. They are 

descr ibed in  the following sect ions, beginn in g on  page 67.

NOTE: If any 

notices were 

received since 

the last time log-

ging in, a mes-

sage will display 

while logging in.

To Review DOJ Notices

This procedure begin s at  the DROS Entry System window. This window is shown  

in  Figure 18  on  page 25.

1. From  the DROS Entry System window, click the Review, Correct or 

Cancel but ton . The Review DROS for Submitted Application window 

appears.

2. Click the Notices but ton . A list  of all not ices with in  the database d isplays 

in  the CFIS Notices window, as shown  in  Figure 44. The types of not ices 

are detailed  in  the following sect ions, beginn ing on  page 67.

A red box in  the Reviewed Date colum n  indicates that  a DROS has not  

been  reviewed.

Click on  a DROS num ber  to d isplay the m essage.

Figure 44:  The Review DROS for Submitted Application Window
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NOTE: Notices 

can also be 

printed by press-

ing Ctrl + P on 

the keyboard.

3. If necessary, click the Setup bu tton  to define the pr in t  setup.

4. Click the Print but ton  to pr in t  the not ice. The pr in t  function  is not  

autom atic, you m ust  click the Print but ton  to pr in t  the n ot ice.

5. Press the Close but ton  to return  to the DROS Entry System window.

The reviewed DROS displays with  the Reviewed Date.
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DMV-Reject DROS Notice

A DMV Reject notice is generated  when  a DROS transact ion  is rejected  and 

return ed  because the dr iver’s licen se or  iden t ificat ion  card  status is not  valid . 

The not ice is also generated  when  the pu rchaser ’s provided in form ation  con flict  

with  the files m ain tain ed  by the Depar tm en t  of Motor  Vehicles (DMV).

After  receivin g the not ice, the dealer  should  cancel the sale an d n ot  deliver  the 

gun  to the purchaser . Consequen t ly, a  DMV-reject  DROS m ust  be resubm it ted  as 

a new transact ion  with  applicable fees and wait ing per iod.

An  exam ple of a pr in ted DMV-Reject  DROS transact ion  not ice is sh0 wn  in  

Figure 45.

Figure 45:  Sample DMV-Reject DROS Transaction Notice
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Delay DROS Notice

A Delay not ice is generated  when  a purchaser ’s eligibility can  not  be determ ined 

by the DOJ  with in  the 10 -day wait ing per iod. If a dealer  receives a Delay not ice, 

they m ust  p lace the sale on  a “tem porary hold” and wait  for  the final 

determ inat ion  from  the DOJ .

Another  not ice will be generated  when  the purchaser ’s eligibility has been  

determ ined.

An  exam ple of a pr in ted  Delay DROS tran sact ion  not ice is shown  in  Figure 46.

Figure 46:  Sample Delay DROS Transaction Notice
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30-Day Multiple Purchase Exemption DROS Notices

A 30-Day Multiple Purchase Exemption not ice is generated  when  a purchaser  

has taken  t it le to on e or  m ore concealable firearm s with in  the past  30  days. As a 

result , the purchaser  is not  eligible under  the Californ ia Penal Code to take t it le 

to another  concealable firearm  at  th is t im e. Therefore, do not  release the firearm  

to the purchaser .

An  exam ple of a pr in ted  30 -Day Mult iple Purchase Exem ption  DROS transact ion  

not ice is shown  in  Figure 47.

Figure 47:  Sample 30-Day Multiple Purchase Exemption DROS Transaction Notice
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Delay/More Information DROS Notices

A Delay/More Info n otice is gen erated  when  m ore in form ation  is needed for  the 

DOJ  to determ ine a purchaser ’s eligibility. If a dealer  receives a Delay/ More In fo 

not ice, they m ust  p lace the sale on  a “tem porary hold” and wait  for  the final 

determ inat ion  from  the DOJ .

Another  not ice will be generated  when  the purchaser ’s eligibility has been  

determ ined.

An  exam ple of a pr in ted Delay/ More In form ation  DROS tran sact ion  n ot ice is 

shown  in  Figure 48 .

Figure 48:  Sample Delay/More Information DROS Transaction Notice
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Deny After Delay DROS Notices

A Deny after Delay not ice is generated as a follow up to a Delay/ More In fo or  

Delay not ice. A Deny after  Delay not ice in dicates that  the purchaser  is n ot  

eligible to possess or  purchase a firearm . Therefore, do not  release the firearm  to 

the purchaser .

An  exam ple of a pr in ted Deny After  Delay DROS transact ion  not ice is shown  in  

Figure 49.

Figure 49:  Sample Deny After Delay DROS Transaction Notice
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Release After Delay DROS Notices

A Release After Delay n otice is gen erated  as a follow up to a Delay/ More In fo or  

Delay Notice. A Release after  Delay not ice indicates that  the eligibility of the 

purchaser  has been  obtained an d the firearm  m ay be delivered to the purchaser .

An  exam ple of a pr in ted  Release After  Delay DROS transaction  n ot ice is shown  

in  Figure 50 .

Figure 50:  Sample Release After Delay DROS Transaction Notice



- 73 -

Application Solutions
April 30, 2007 3:36 pm TD

Reviewing DOJ Notices

DROS Entry System for the Internet
DROS Entry Application User Manual

Doc Ver 9.02 / App Ver 3.34

Denial DROS Notices

A Denial not ice is gen erated  when  DOJ  records in dicate that  the purchaser  is n ot  

eligible to possess a firearm . Therefore, do not  release the firearm  to the 

purchaser .

In  the case of a Pr ivate Par ty Sale, if the purchaser  is proh ibited  from  possessing 

a firearm , a background check is then  per form ed on  the seller . If the seller  is 

proh ibited, the dealer  m ust  n ot  return  the firearm  to the seller . In stead, the 

firearm  should  be sur ren dered to law en forcem en t .

An  exam ple of a pr in ted Den ial DROS transact ion  not ice is shown  in  Figure 51.

Figure 51:  Sample Denial DROS Transaction Notice



- 74 -

Application Solutions
April 30, 2007 3:36 pm TD

Reviewing DOJ Bulletins

DROS Entry System for the Internet
DROS Entry Application User Manual

Doc Ver 9.02 / App Ver 3.34

Reviewing DOJ Bulletins

You have the opt ion  to review DOJ  bullet in s issued dur ing the past  30  calendar  

days.

To Review DOJ Bulletins

This procedure begin s at  the DROS Entry System window. This window is shown  

in  Figure 18  on  page 25.

1. From  the DROS Entry System window, click the Review, Correct or 

Cancel but ton .

The Review DROS for Submitted Application window appears, sim ilar  to 

Figure 52.

2. Click the Bulletins but ton .

A list  of all bullet in s with in  the database d isplays in  the CFIS Bulletins 

window, sim ilar  to Figure 52.

Figure 52:  The CFIS Bulletins Window

3. Click on  a bullet in  num ber  to d isp lay the bullet in  in  the window, sim ilar  

to Figure 53.
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Figure 53:  The Displayed Bulletin

NOTE: Bulletins 

can also be 

printed by press-

ing Ctrl + P on 

the keyboard.

4. Click the Print bu t ton  to pr in t  the bullet in . The pr in t  function  is not  

autom atic, you m ust  click the Print but ton  to pr in t  the bullet in .

5. Click the Close but ton  to return  to the DROS Entry System window.
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Accessing the Help Function

The Help  funct ion  provides an  overview of the DROS En try  Sy stem  process, 

t roubleshoot in g t ips, an d a list  of Frequen tly Asked Quest ions. Th is funct ion  is 

accessed  from  the DROS Entry System window or  from  the Main Menu before 

logging in to the system .

To Access the Help Function

1. From  the DROS Entry System window, click the Help but ton  from  the 

DROS Entry System window.

The Review DROS for Submitted Application window appears. The help  

text  d isplays on  the screen .

2. Scroll th rough  the in form ation  by clicking the up and down  ar rows or  

clicking on  the scroll bar  with  the m ouse and m oving the bar  in  the 

necessary d irect ion .

NOTE: Help text 

can also be 

printed by press-

ing Ctrl + P on 

the keyboard.

3. Press the Print bu t ton  to pr in t  the help  text .

4. Press the Close but ton  to return  to the DROS Entry System window.
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Logging Off from the DROS Entry System

Logging off refers to exit ing the DROS En try System  and discon nect ing from  the 

In ternet . Th is is a separate procedure from  shut t ing down  the com puter . When  

you fin ish  usin g the system , you should  log off.

To Log Off from the DROS Entry System

This procedure begins at  the DROS Entry System window. Th is window is shown  

in  Figure 18  on  page 25.

1. From  the DROS Entry System window, click the Log Off but ton . The 

m en u becom es d isabled .

2. Close the DROS Entry System window by clicking the X bu t ton  in  the 

upper  r igh t  por t ion  of the browser  screen , or  by select ing the Close 

Window opt ion .

3. Disconnect  from  the In ternet . You can  do th is a n um ber  of ways. Righ t-

click or  double-click the telephon e connect ion  icon  in  the Status Bar  (at  

the bot tom  of the screen ). If you r igh t-click the icon , choose Disconnect. 

If you double-click the icon , the system  disconnects from  the In ternet .
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A. Troubleshooting Tips
This chapter  con tain s t roubleshooting t ips that  m ay help  if you exper ience 

problem s with  the DROS En try  Sy stem  applicat ion .

Som e problem s m ay be direct ly related to the com puter  or  pr in ter  an d un related 

to the DROS applicat ion . Please consult  the own ers m an uals supplied  with  the 

com puter  an d pr in ter .

Problem Solution

Drop-down menus (such as race, 

origin of gun, ZIP Codes, etc.) are 

not populating with options.

When logging into the application, click the check box in 

the lower-left corner of the Login window. This will force 

the download of drop-down menu options. This check 

box should only be checked if any drop-down menus are 

not populating. Checking this option will increase login 

time by two to five minutes.

Modem is connected to a private 

branch exchange (PBX) telephone 

network.

Contact your Internet Service Provider (ISP) for 

information on configuring your Internet connection 

settings for a PBX telephone network.

A connection cannot be made to 

the DROS system.

The DROS Entry System (DES) is available to receive 

and transmit a DROS, Notices and Bulletins from 7:00 

a.m. until 11:00 p.m. seven days a week.

The DROS Entry System 

application automatically logs off.

As a security measure, the DROS Entry System 

application automatically logs off after five minutes of 

inactivity. Log into the application again.

Printer does not print. Do this if the printer does not print:

• Check to see if the printer’s power light is on. It 

should be green.

• If it is not on, check to see if it is plugged in to both 

the wall outlet and the back of the computer.

• Print a test page:

• In the lower left corner of the screen, select Start > 

Settings > Printers.

• Right click on the printer icon and choose Properties 

from the menu options.

• Click on the Print Test Page button.

• From the same screen, verify that the printer is set as 

the Default Printer.

• Try using the keyboard to print. Hold down the Ctrl + 

P keys.

The DROS is printing on two 

pages.

You will need to change the setting in Internet Explorer.

From the Internet Explorer menu select View > Text 

Size > Smaller.
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Page numbers and web address 

information is printing on the 

DROS.

The Internet Explorer font setting may need to be 

changed.

From the Internet Explorer menu select File > Page 

Setup, then delete the text from the Header and Footer 

fields.

Your internet connection randomly 

disconnects.

If your phone line has “Call Waiting” service, this may 

cause disruption in the phone signal. The code to 

disable the call waiting may be different depending on 

your service. Look in the front of your White Pages 

listings for information on this, or contact your local 

phone company.

Can not log in. Verify that you are entering the correct Dealer ID and 

Password. These are both case sensitive.

Check to see that “Caps Lock” is turned off.

A software error message is 

displayed.

As you work in the DROS Entry System, you may see 

messages indicating an error has occurred. You may 

need to call the DROS Service Center for assistance.

Before you call, write down the exact wording of the 

message, including any numbers or table names that 

may be referenced. For example, if the following 

message is displayed:

Could not find table 'table name'. Please contact the 

CFIS Service Center.

Copy down the name of the table and report it to the Call 

Center.

The application has “locked up” 

when logging in.

Periodically a new version of the application is available. 

This new version automatically installs the next time you 

log in. The first time you log into the application it will 

take about 12 to 15 minutes (depending on the speed of 

your connection and traffic on the network.)

Once you have made the initial installation, new updates 

load much quicker. Usually, updates load within a few 

minutes.

The card swipe window locks up 

after the dealer scans the driver 

license or identification.

Re-scan the card again. It is not necessary to log off 

from the application or shut down the computer.

The card swipe window will not 

display.

If the ID card is for the buyer, press F5 in the Purchaser 

window. If it is for a seller, press F6 in the Seller window.

An ID card has been swiped, but 

no information is populating the 

screen.

Sometimes the stripe can become scratched and will not 

work properly. Try placing the ID card in a plastic 

shopping bag. Swipe the card with the bag wrapped 

around the strip.

Occasionally, the magnetic stripe on the back of the ID 

card becomes demagnetized. If this happens, the 

information will have to be manually entered.

Problem Solution
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The application will not accept the 

ZIP Code information.

Verify that the ZIP Code is a valid postal code for 

California. The system will not accept out-of-state ZIP 

Codes.

Cannot access the DROS Entry 

System application through 

Netscape.

The DROS Entry System application is only supported 

for use with Microsoft Internet Explorer 4.0, 5.0, 5.5 or 

6.0.

Cannot access the DROS Entry 

System application using an Apple 

computer, such as an iMac.

The DROS Entry System application is only supported 

using a Microsoft Windows-based computer.

Problem Solution
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B. Quick Reference

Operating Hours

The DROS En try System  is available to receive and t ransm it  a DROS, Notice or  

Bullet in  from  7:0 0  a.m . un til 11:0 0  p .m ., seven  days a week.

Logging into the DROS Entry System

For  detailed in form ation , see the sect ion  “Logging in to the DROS En try System ” 

on  page 21.

1. Open  the browser  on  your  com puter  (In ternet  Explorer  4.0 , 5.0 , 5.5 or  

6.0 ).

2. In  the Address field  at  the top of the screen , en ter  th is address: http://

caag.state.ca.us/firearms.

3. In  the DOJ Bureau of Firearms website, click the CA Firearms Dealer 

DROS Entry System Access link located  near  the bot tom  of the page.

4. Choose DROS Entry from  the Consolidated Firearms Information System 

(CFIS) screen .

5. At the DROS Entry System Login window, en ter  your  Dealer ID and  

Password and click the OK but ton .

Navigating Through the DROS Entry System

1. Press the Tab key to m ove forward between  fields; press Shift + Tab to 

m ove backward.

2. Press the Page Up or  Page Down keys to scroll up or  down  with in  a 

win dow.

3. Press the Delete or  Backspace key to erase an  en try from  a field .

Entering a DROS

For  detailed  in form ation , see the chapter  “Processing a DROS” on  page 29.

1. From  the DROS Entry System window, select  the appropr iate m enu 

opt ion  for  the type of t ransaction  and firearm  (such  as Dealer  Sale 

H andgun).

2. Com plete the appropr iate sect ion s.

3. Click the Preview but ton  to review the DROS.

4. Click the Submit bu t ton  to send the DROS to the DOJ  and receive a 

DROS num ber .



- 84 -

Application Solutions
April 30, 2007 3:37 pm TD

DROS Entry System for the Internet
DROS Entry Application User Manual

Doc Ver 9.02 / App Ver 3.34

To Scan a Purchaser’s Driver’s License or Identification

1. Press the F5 key to d isplay the Read Purchaser California ID or DMV 

Card window. 

2. Using the m ag str ipe reader , scan  the purchaser ’s dr iver ’s license or  

iden t ificat ion . 

3. When  the in form ation  has been  retr ieved, the window closes and the 

appropr iate fields are populated . 

To Scan a Seller’s Driver’s License or Identification

1. Press the F6 key to d isplay the Read Seller California ID or DMV Card 

window. 

2. Using the m ag str ipe reader , scan  the seller ’s dr iver ’s licen se or  

iden t ificat ion .

3. When  the in form ation  has been  retr ieved, the window closes and the 

appropr iate fields are populated .

Reviewing, Correcting or Canceling a DROS

1. From  the DROS En try  Sy stem  window, select  the Review, Correct or 

Cancel but ton .

2. Select  the appropr iate m enu opt ion , or  en ter  the DROS num ber  and click 

the Review but ton .

3. If you are viewin g a Bullet in  or  Notice, select  the appropr iate docum en t  

to d isplay it  on  the screen . You can  review the docum en t  from  the screen  

or  pr in t  it  out . If you select  a DROS you can  cor rect , cancel, or  pr in t  the 

DROS. Click the Close but ton  to return  to the DROS Entry System 

win dow.

Logging Off from the DROS Entry System

1. From  the DROS Entry System window, click the Logoff but ton .

2. Close the DROS Entry System window by clicking the X in  the upper  

por t ion  of the browser  screen .

3. Disconnect  from  the In ternet  by clicking on  the telephone connect ion  

icon  in  the status bar  in  the browser  screen  and choose Disconnect.

Getting Help

For  DROS En try  Sy stem , PSD Hardware, com puter  suppor t , t ran sm ission  or  

billing concerns, call the DROS Service Cen ter  at  1-800-974-3767.

TIP: Have your 

CFD ready before 

calling the ser-

vice center.

Service professionals at  the DROS Service Cen ter  are available to assist  you from  

9:0 0  a.m . un t il 9:0 0  p .m ., Monday th rough  Saturday, and from  10 :0 0  a.m . un t il 

6:0 0  p .m . on  Sunday.
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C. Release Notes
The followin g revision s have been  m ade to the DROS En try  Applicat ion :

Version Date Application Change

3.34 04/24/2007 The following changes/enhancement have been made in version 

3.34:

• Login screen has been modified to allow the user to change the 

master or secondary password.

• All MCI logos have been replaced with Verizon Business logos.

• All references to the Attorney General have been updated to the 

name of the new Attorney General.

• Perjury statement has been updated.

• All text and logos referencing the “Firearms Division” have been 

updated to the new “Bureau of Firearms” logo and text.

3.30 07/16/04 The following changes/enhancements have been made in version 

3.30:

• Change made to the four yes/no questions related to firearms 

eligibility that the firearms purchaser is required to answer. The 

change has occurred on all of the screen and printed DROS 

copies. Specifically, the text of the existing question #2 was 

deleted and replaced with the following: Is purchaser a danger/

threat to self or others pursuant to welfare and institutions code 

(WIC) Section 8100, or a person who has been admitted to a 

mental HEALTH FACILITY AS A DANGER TO SELF OR 

OTHERS PURSUANT TO WIC SECTION 5151, 5151, AND/OR 

5152 WITHIN THE PAST FIVE YEARS?

• I-94 field now allows a “0” as the first character.

• Application is now digitally signed & verified by Versign. When 

you click on the application it shows the certificate and asks you 

if would like to download.

3.22 05/11/2004 The following changes/enhancements have been made in version 

3.22:

• Option for selecting a Country of Citizenship added to Purchaser 

and Seller screens.

• Country of Citizenship field added to DROS.

3.21 12/31/2003 The following changes/enhancements have been made in version 

3.21:

• DROS format changes. Modified DROS to allow manual entry of 

delivery date/time and dealer information on printed DROS.

• System now allows a DROS to be cancelled or corrected within 

a 31-day period.
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3.21 8/13/2003 The following changes/enhancements have been made in version 

3.21:

• United States Citizen drop-down list added to indicate whether 

purchasers and sellers are citizens of the United States.

• Alien Registration # and I-94 # fields added to record 

information about purchasers and sellers that are not citizens of 

the United States.

• Notice alert added to login process.

• Passport and Out of State ID sources have been removed.

• HSC field now allows alpha-numerics to be entered.

• Review Date field was added to the Review DROS for Submitted 

Application window.

3.20 5/16/2003 The following changes/enhancements have been made in version 

3.20: 

• Print Preview button has been added, allowing users to preview 

a DROS before it is submitted to the Department of Justice.

• Sort order of Notice letters has changed.

3.11 2/1/2003 The following changes/enhancements have been made in version 

3.11: 

• Fixed problems with card swipe readers not reading city names 

more than 12 characters. 

• Added a check box to the login window for users to force 

download of drop-down menus like race, origin of gun, zip 

codes, etc. This check box should only be checked if any drop-

down menus are not populating.

Version Date Application Change
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3.09 11/26/2002 The following changes/enhancements have been made in version 

3.09: 

• All references to SB15 legislation have been removed from the 

DROS Entry System, as the number has been recycled this year 

to other legislation. 

• AB35 SB/52 requires that all statutory requirements of the Basic 

Firearms Safety Certificate (BFSC) be replaced with the 

statutorily mandated Handgun Safety Certificate (HSC) 

requirements. All new HSC exemptions codes and translations 

were inserted into the drop-down menu and the old BFSC codes 

and translations were removed. On the DROS Entry screen, 

BFSC Number and BFSC Exemption Code have been replaced 

with HSC Number and HSC Exemption Code. The hard copy 

DROS printed out at the dealer's place of business was changed 

to reflect the new HSC Number and BFSC Exemption Code. 

BFSC will no longer appear on the DES or the dealer's hard 

copy DROS. 

• Added edits to the DROS Purchaser and Seller fields to ensure 

that Purchaser ID # and Seller ID # are not the same when 

name and DOB of purchaser and seller are not the same. 

• Peace officer's under 21 years of age cannot purchase firearms 

• Fixed problem with empty drop-down menus. 

• Fixed 'PL/SQL: NUMERIC OR VALUE ERROR'.

• Appropriate message now displays when dealer’s status is 

inactive. 

• Added new Setup button for first time users to install required 

files rather than downloading every time application changes. 

• “NON PROFIT” waiting period exemption has been removed.

3.07 5/24/2002 First release of DROS Entry System for the Internet application.

Version Date Application Change
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Revision History
The followin g revision s have been  m ade to the DROS En try  Sy stem  for  the 

In tern et  DROS En try  Applica tion  User  M anual:

 Version Date Change Author

9.02/3/34 04/30/2007 Changed “MCI” to “Verizon Business” in the Printing a CA 

Firearm Dealer Billing Enrollment Form section. Updated 

screen captures of the DROS Entry System home page.

TD

9.01/3.34 04/26/2007 Removed Verizon Business mailing address from title 

page.

TD

9.00/3.34 04/25/2007 Updated screens and text to reference name and logo 

change from Firearms Division to Bureau of Firearms.

TD

8.00/3.34 12/08/2006 Added instructions for changing passwords and updated 

all logos for Verizon branding.

TD

7.01/3.30 12/11/2006 Applied Verizon Business template and FrameMaker 

EDD version 1.04 to the document.

TD

7.00 07/23/04 The following changes were made to the user manual for 

version 3.30 of the application:

• In the Private Party Transfer section, corrected text in 

note regarding sellers with out-of-state licenses.

• Made all instructions for setting Internet Explorer 

security settings consistent.

TD

6.00 07/16/04 The following changes were made to the user manual for 

version 3.30 of the application:

• Updated all screen captures of Login screen to include 

new version number of application.

• Updated screen capture of Purchaser tab to included 

changes to questions at bottom of screen.

• Added note to Private Party Transfer section that 

indicates that seller’s will out-of-state licenses can not 

enter an ID using this application.

• Updated instructions for setting ActiveX controls.

TD
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5.00 05/12/04 The following changes were made to the user manual for 

version 3.22 of the application:

• Screen captures of Login screen were updated for new 

version number.

• Screen captures of Purchaser screen were updated to 

include new Country of Citizenship field.

• Screen captures of Seller screen were updated to 

include new Country of Citizenship field.

• Instructions for selecting Country of Citizenship were 

added to sections describing Purchaser and Seller 

screens.

• Version number was updated to conform to new 

version numbering standard for user documentation.

• References to Country of Origin field changed to 

Country of Citizenship.

TD

3.21 12/31/2003 The following changes were made to the user manual for 

version 3.21.

• Updated screen captures of all DROS to include new 

delivery date and dealer information fields.

• Added instructions to manually enter delivery date and 

dealer information on printed DROS.

• Updated screen captures of all DROS notices.

TD

3.21 08/13/2003 The following changes were made to the user manual for 

version 3.21.

• Manual was renamed from “DROS Training Guide” to 

“User Manual”.

• Instructions for setting up the DOJ-supplied personal 

computer were removed and separate installation 

manual was created.

• Instructions were added for entering citizen 

information.

• New notice alert at login process was documented.

• Screen captures were updated to reflect screen 

changes and new application version number.

TD

3.20 5/16/2003 The following changes were made to the training guide 

for version 3.20.

• Updated screen captures of DROS entry screens to 

include Preview button.

• Added section with instructions for previewing a 

DROS.

• Added section with instructions for printing a California 

Firearm Dealer Billing Enrollment Form.

• Added release notes.

• Changed all references of Worldcom to MCI.

TD
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3.11 1/17/2003 The following changes were made to the training guide 

for version 3.11.

• Added description of check box to instructions for 

logging into the application. 

• Added troubleshooting tip for check box in Login 

window. 

• Updated software version number and release notes 

for version 3.11.

• Updated screen captures of Login windows. 

TD

3.09 1/15/2003 Changed printer installation instructions to reflect that a 

parallel printer cable is not included with the DOJ 

computer.

TD

3.09 11/26/2002 Updated computer installation section with new images 

and instructions. Changed installation section to allow for 

generic computer setup. Added Release Notes chapter.

TD

3.09 8/26/2002 Changed printer software setup to a manual process. TG

3.07 5/24/2002 First release of training guide. TD

 Version Date Change Author
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Loan Transaction, 56

Logging In, 21, 83
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S
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